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KENDRIYA VIDYALAYA SANGATHAN : HYDERABAD REGION 

SUBJECT : INFORMATION TECHNOLOGY - CLASS 10  
 

STUDY MATERIAL PREPARATION 

 

SNO NAME OF THE TEACHER KV TOPIC ALLOTTED 

1 Mrs K SRIKANTHA  PICKET Communication Skills-II. 

MULTIPLE CHOICE QUESTIONS 

1 . In oral communication, there is a possibility of ___________ response 
a. Late 
b. Immediate 
c. No 
d. slow 

 
Correct Answer : b) immediate 

2 What are close-ended questions? 
a. Questions that do not have answers 
b. Questions with single line answers 
c. Questions with yes/no answers 
d. Questions with multiple line answers 

Correct answer : c) Questions with yes/no answers 

3 Questions can be formed with one of the following 
a. 5W 1H 
b. 5H 1W 
c. 4W 2H 
d. 4H 2W 
Correct answer : a) 5W 1H 

4 Which of the following is an imperative sentence? 
a. May I come in please 
b. Wow I won the match 
c. What is your name? 
d. Get out of my class 

Correct answer : d) Get out of my class 

5 A group of ideas that form a complete paragraph and a A group of words that 
communicate a complete thought is known as ___________ 
a. Sentence 
b. Phrase 
c. Article 
d. Parts of speech 

Correct answer : a) Sentence 

Rectangle

Rectangle

Rectangle



3 
 

6 Identify the sentence in passive voice 
a. Latha sings a song 
b. Latha is singing a song 
c. A song is sung by Latha 
d. A song was being sing by Latha 

Correct answer : c) A song is sung by Latha 

7 For proper capitalisation of letters in a sentence, we use the ______ rule 
a. MINTS 
b. TINSU 
c. STUNT 
d. NUTS 

Correct answer : a)MINTS 

8 Which of the following is not a barrier of communication? 
a. Linguistic barrier 
b. Cultural barrier 
c. Financial barrier 
d. Physical barrier 
Correct answer : c) Financial barrier 

9 Superior-subordinate relationships in a formal organisational structure is a type of ______ 
a. Cultural barrier 
b. Organisational barrier 
c. Interpersonal barrier 
d. Employee barrier 
Correct answer : b) Organisational barrier 

10 Our communication can only be effective if we follow the basic principles of professional 
communication skills which include _____. 
a. 6C’s 
b. 7C’s 
c. 8C’s 
d. 5C’s 

Correct Answer : b)7C’s 

 

CASE STUDY QUESTIONS (R) 

1 Raghav is the class monitor. He wants to know why Ramesh is coming late every 
day. Which of the following is a question that Rafhav can ask Ramesh?  
(a) Do you come on time?  
(b) Are you late? 

 (c) Why are you late every day?  
(d) Will it not be easier to complete your work if you come on time?  
Ans c 

2 If you have not understood a task given to you, which question should you ask? 

 (a) Where are the reports of this task? 

 (b) Can you repeat the instructions for this task? 
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 (c) Can you give me an example of this task? 

 (d) Why are you doing this task? 

 Ans b  

3 Sheela does not have time so she decides to delay a task. Which question should 
he ask before ignoring the task? 

 (a) What is this task?  
(b) When does this task need to be completed?  
(c) Is this task important?  
 (d) No need to ask any question. 
 Ans. B 

4 Renuka is joining a new school. Which of the following questions will help her 
become comfortable with her new classmates?  
(a) How long have you been studying here?  
(b) Would you like to share my lunch? 

 (c) What do you all do in your free time? 

 (d) All the options are correct.  
Ans d  

5 Raju is dumb but a good friend of Meena studying in class X. Here Raju can only 
communicate to Meena through 

 a. Object communication 

 b. Written communication  
c. Oral communication 

 d. Non- verbal communication 

Ans : d 

6 Jayraj lives at a hostel in Shimla. He calls his mother who lives in Delhi, to get her 
approval for the robotics class which is going to start in his school next week onwards. 
Here Jayaraj is the _________ a. Channel  
b. Sender 
 c. receiver  
 d. Response  
Ans b 

7 
Vipul Group of company aims that all his employees work together for the common goal of 
the organization and the reason for this collective and collaborative work is  

a. Communication 

 b. Conversation 

 c. combination  
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d. All the above  

Ans: d  

8 Rani, Meena and Reena are friends and they usually meet and have a get together. The 
type of communication amongst is ___. 
 a. impersonal  
b. Interpersonal 
 c. personal  
d. Important 
 Ans: c 

9 Trident company has too many rules and regulations for the employees. Too much of ___ 
communication in the workspace may also prove ___. It may lead to negligence of work.  
a. formal, positive 
 b. informal, negative 
c. verbal, positive  
d. non-verbal, negative  
Ans: b  

10 Find out errors: Either the manager or their subordinates failed in his duty.  
a. either- neither, or- nor  
b. their- his, his- their 
c. failed- fails, subordinates- subordinate  
d. the- a, in- for  
Ans: b  
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SNO NAME OF THE TEACHER KV TOPIC ALLOTTED 

2 Mr CH VENUGOPALA RAO BOWENPALLY Self-Management Skills 

MULTIPLE CHOICE QUESTIONS 

1 What makes you complete work or studies without others cheering you? 
(a) Self-confidence      (b) Communication (c) Self-motivation (d) Self-esteem 
Ans. c  Self-motivation  

2 Stress causing agents are : 
a. Mental      b. Physical   c. Financial   d. All of the above 
Ans. d. All of the above 

3 Importance of stress management is/are 
a. Improves mood    b. Boosts immune system   c. Increases efficiency        d. All of 
the above 
Ans. d. All of the above 

4  _____________ is a practice where an individual is supposed to focus his/her mind. 
a. Yoga         b. Physical Exercise            c. Meditation            d. Nature Walk 
Ans. c. Meditation 

5 Stress management prevents _____________________ 
a. psychological disorders               b. behavioral problems        c. both of the above 
d. none of the above 
Ans. c. both of the above 

6 Stress refers to _________strain/tension. 
a. Physical   b. Mental      c. Emotional             d. All of the above 
Ans. d. All of the above 

7 ______________ refers to human efforts for maintaining healthy body and mind.. 
a. Stress Management        b. Self Motivation     c. Self Regulation    d. None of the 
above 
Ans. a. Stress Management 

8 _________________ is simply the force within you that drives you to do things. 
a. Self-Awareness   b. Self-Regulation    c. Self-Motivation     d. None of the above 
Ans. c. Self-Motivation 

9 _____________ is/are Stress Management Technique. 
a. Physical Exercise            b. Yoga         c. Meditation            d. All of the above 
Ans. d. All of the above 

10 ________________ stress makes a person worrisome, less productive and may lead to 
various disorders. 
a. Negative   b. Positive    c. Both of the above            d. None of the above 
Ans. b. Positive 
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CASE STUDY QUESTIONS (R) 

1 Breathlessness, dry mouth, butterflies in stomach, indigestion etc are sign of _________ 
stress. 
a. Mental      b. Physical   c. Both of the above            d. None of the above 
Ans. b. Physical 

2 Irritation, impatience, loneliness, upset mood, anxiety are sign of __________ stress. 
a. Mental      b. Physical   c. Emotional             d. None of the above 
Ans. a. Mental 

3 Gopal participated in a 100m race and won a prize. This motivated him to go for practice 
every morning. What type of Motivation is this? 
a. Internal      b. Intermediate          c. External     d. None of the above 
Ans. c. External 

4 Venu  performed on annual day function and learn something new, such as dancing, 
singing, etc What type of motivation is this? 
a. Internal      b. External     c. Intermediate          d. None of the above 
Ans. a. Internal 

5 Students may feel __________ stress if they are unable to submit their assignment. 
a. Physical   b. Financial   c. Mental      d. None of the above 
Ans. c. Mental 

6 Having conscious knowledge of your own self, capabilities, feelings and one’s own 
character is called as _____ 
a. Self-Regulation    b. Self-Motivation     c. Self-Awareness   d. None of the above 
Ans. c. Self-Awareness 

7 Issues related to health of an individual can lead to low self-esteem and cause 
___________stress. 
a. Financial               b. Emotional             c. Mental                  d. Physical 
Ans. d. Physical 

8 Ability to work independently can be enhanced by being _____________ 
a. Self-aware           b. Self-motivated     c. Self-regulated      d. All of the above 
Ans. d. All of the above 

9 Stress management prevents _____________________ 
a. psychological disorders  b. behavioral problems c. both of the above 
d. none of the above 
Ans. c. both of the above 

10 Which of the following help to manage stress? 
a. Self-awareness of symptoms of stress. 
b. Speaking out to the well-wishers like family and friends. 
c. Both of the above 
d. None of the above 
Ans. c. Both of the above 
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SNO NAME OF THE TEACHER KV TOPIC ALLOTTED 

3 Mr T SREENIVASA RAO WALTAIR Information and Communication 
Technology 

 Skills –II 

MULTIPLE CHOICE QUESTIONS 

1 1. ICT stands for _______________ 

a. Information and Communication Technology 

b. Information and Communication Terminology 

c. Information and Common Technology 

d. Information to Communication Technology 

2 2. Which extension is given to the Writer document by default? 
 
(a) .odt 
(b) .com 
(c) .doc 
(d) None 

3 3. Which of the following will you opt for saving a file? 

(a) save button on standard toolbar 
 (b) save option from file menu 

(c) pressing Ctrl+S 

 (d) any of the above 

4 4. Full form of WYSIWYG 

(a) WHAT YOU SAVE IS WHAT YOU GET 
(b) WHAT YOU SEE IS WHAT YOU GET 
(c) WHAT YOU SELECT IS WHAT YOU GO 
(d) WHAT YOU SEND IS WHAT YOU GOT 

5  WELCOME  
 INTRODUCTION 
 OVERVIEW 

A (n)________, like that shown before the points listed in figure above, is a dot or other 
symbol positioned at the beginning of a paragraph. 
 
(a) bullet  
(b) logo 
(c) cell 
(d) target 

6 6. A cell address’s correct form is _________ , ________. 

(a) row number,column letter  
 (b) column letter,row number 
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(c) column number,row number  
  

 (d) None of the above 

7 7.professional looking visual aids are prepared with the help of a software called 
  

a. DBMS 
  

b. Multimedia software 
  

c. Graphics software 
  

d. Presentation Graphics Software 
 

8 8. Which function key allows you to run the slideshow? 
  

a. F1 
  

b. F3 
  

c. F5 
  

d. F7 
 

9 9. custom animation is available on the ________ menu. 
  

a. Edit 
  

b. Tools 
  

c. Slide show 
  

d. Insert 

10 10.the animation shown when one slide moves to another slide is known as_____ 
  

a.animation 
  

b.design 
  

c.transition 
  

d.hyperlink 
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CASE STUDY QUESTIONS (R) 

1 
 In Writer,when a word does not fit on a line,it automatically flows to the beginning of the 
next line.this is called_________ 

a.line drop  

b.word wrap 

c.line wrap 

d. None of the above 

2 Statement 1:Ctrl+S shortcut is used to select text in OOo Writer. 

Statement 2:Ctrl+X is used to remove the data. 
a.both statement 1 and statement 2 are correct. 
b.both statement 1 and statement 2 are incorrect. 
c.statement 1 is correct but statement 2 is incorrect 
d.statement 1 is incorrect but statement 2 is correct 

3 
the autocorrect feature is used to automatically correct common misspellings that users 
generally do or common typing errors.what is the shortcut key for it 

a.F6 

b.F5 

c.F7 

d..F2 

4 Statement 1:a cell is a single box where a row and column intersect. 

Statement 2:.table is made up of horizontal rows and vertical columns,with lines or 

borders around each column and row. 
 
a.both statement 1 and statement 2 are correct. 
b.both statement 1 and statement 2 are incorrect. 
c.statement 1 is correct but statement 2 is incorrect 
d.statement 1 is incorrect but statement 2 is correct 

5 Statement 1:a range is specified by giving the addresses of the first cell and the last cell 

of the range separated by some symbol character. 
Statement 2:. if you enter 12+24 in a cell, Calc will display 12+24 
 
a.both statement 1 and statement 2 are correct. 
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b.both statement 1 and statement 2 are incorrect. 
c.statement 1 is correct but statement 2 is incorrect 
d.statement 1 is incorrect but statement 2 is correct 

6 Statement 1:a slide layout is an organized set of elements,using which a new slide can 

be created 
Statement 2:slideshow is the name of a running electronic presentation  
a.both statement 1 and statement 2 are correct. 
b.both statement 1 and statement 2 are incorrect. 
c.statement 1 is correct but statement 2 is incorrect 
d.statement 1 is incorrect but statement 2 is correct 

7 Statement 1:The Print icon appears on standard toolbar  

Statement 2:the printed copy of a document is called a hard copy 
a.both statement 1 and statement 2 are correct. 
b.both statement 1 and statement 2 are incorrect. 
c.statement 1 is correct but statement 2 is incorrect 
d.statement 1 is incorrect but statement 2 is correct 

8 during copying of the formula the relative cell addresses automatically get adjusted w.r.t 
current cell where the formula is being copied.this process is called___________ 

a.absolute referencing 

b.partial referencing 

c.relative referencing 

d.None of the above 

9 Statement 1: In Calc,you can sort by upto two criteria, with each criterion applied one 

after the other 
Statement 2:Alt+P is the shortcut key for printing 
a.both statement 1 and statement 2 are correct. 
b.both statement 1 and statement 2 are incorrect. 
c.statement 1 is correct but statement 2 is incorrect 
d.statement 1 is incorrect but statement 2 is correct 

10 Statement 1: a presentation can also be printed using Ctrl+P 

Statement 2::we can use parentheses to group operations in the order you want 
a.both statement 1 and statement 2 are correct. 
b.both statement 1 and statement 2 are incorrect. 
c.statement 1 is correct but statement 2 is incorrect 
d.statement 1 is incorrect but statement 2 is correct 
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SNO NAME OF THE TEACHER KV TOPIC ALLOTTED 

4 Mr R VIJAY KUMAR MACHILIPATNAM Digital Documentation 
(Advanced) 

MULTIPLE CHOICE QUESTIONS 

1 
Which of the following is true about styles? 

a)    A style is a set of formats that you can apply to selected pages, text, frames, and other 
elements in your document to quickly change their appearance. 

b)    Styles are logical attributes. 

c)     Styles help improve consistency in a document. 

d)    All of the above 

Ans) d 

2 
Read statements 1 and 2 and select appropriate option? 

Statement 1: A new style can be created from selection 

Statement 2: A new style can be created using drag and drop 

a)    Both statements 1 and 2 are True 

b)    Statement 1 is True but Statement 2 is False 

c)     Statement 1 is False but Statement 2 is True 

d)    Both statements 1 and 2 are False 

Ans) a 

3 
We can add an image to a document using 

a)    Drag and drop 

b)    Insert > Picture > From File     from the menu bar 

c)     Both of the above 

d)    None of the above 

Ans) c 
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4 
The Graphics filter Posterize: 

a)     Joins groups of pixels into a single area of one colour 

b)     Makes a picture appear like a painting by reducing the number of colours used  

c)      Simulates the effects of time on a picture 

d)     Increases the contrast of an image 

Ans) b 

5 
The __________ option in picture tool bar is particularly useful when creating a watermark 
or when wrapping the image in the background 

a)    Transparency 

b)    Filter 

c)     Color 

d)    None of the above 

Ans) a 

6 
_____________ refers to the relation of graphics to the surrounding text. 

a)    Arrangement 

b)    Anchoring 

c)     Text wrapping 

d)    Alignment 

Ans) c 

7 
Which of the following statements is True about Templates? 

Statement 1: A template is a model that you use to create other documents 

Statement 2: Templates cannot contain things that regular documents can contain, such 
as text, graphics, a set of styles etc., 

a)    Both statements 1 and 2 are True 
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b)    Statement 1 is True but Statement 2 is False 

c)     Statement 1 is False but Statement 2 is True 

d)    Both statements 1 and 2 are False 

Ans) b 

8 
While creating table of contents through insert index/table dialog box , which tab is 
available out of the following give tabs 

a)    Entries tab 

b)    Styles tab 

c)     Background tab 

d)    All the above tabs 

Ans) d 

9 _________ is a feature in word processing software that help users to create personalized 
letters, greeting cards with different names and addresses stored in a database. 

a)    Table of contents 
b)    Templates 
c)     Mail Merge 
d)    None of the above 

Ans) c 

10 What is the shortcut to see non – printing characters in Writer? 
a) Ctrl + F11 
b) Ctrl + F12 
c)  Ctrl + F1 
d) Ctrl + F10 

Ans) d 

 

CASE STUDY QUESTIONS (R) 

1 Mr. Vamsi as part of his project work created a document in open office writer with some 
ten pages of text. For proper explanation of the content he wants to add images at 
different locations in the document. Help him to complete the following tasks. 

a) Mr. Vamsi wants to add an image as water mark to his document. Which feature from 
picture tool bar he can use for this purpose? 
Ans) Graphics mode option can be set as watermark 
      (or) 
     Transparency can be increased with appropriate text wrapping  
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b) Which graphic filter option he should use on the image to group pixels into a single area of 
one colour? 
Ans) Mosaic 

c) Which option from the crop tab he should choose if he does not want to change the scale 
of the picture? 
Ans) Keep scale 

d) Which option he can use from the picture dialog box so that he can conveniently align text 
with image as per his requirement? 
Ans) Wrap 

e) While resizing the image if he wants to control only one dimension at a time which handle 
he can use? corner handle or non corner handle? 
Ans) Non corner handle 

2 Ms. Priya has 40 pages of text prepared by her on a specific topic in open office 
writer with proper use of headings where ever required. Now she wants to create an 
index for the pages she created so that all the topics and sub topics are clearly 
visible with page numbers for easy access. Help her to complete the following tasks 
.   

a) Name the feature in open office writer that she can use to create a table of contents 

Ans) Indexes and Tables 

b) If she’d like to have title for table of contents then where she can find the option to add 
title? 
Ans) Title field under Index/Table tab 

c) Which tab under insert index/table allows her to add and delete elements for each outline 
level? 
Ans) Entries 

d) She can use Background tab under insert index/table - to select a graphic as 
background True or False? 
Ans) True 

e) Which tab under insert index/table allows her to apply paragraph styles to the table of 
contents? 
Ans) Styles 
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SNO NAME OF THE TEACHER KV TOPIC ALLOTTED 

5 Mr RAVI KUMAR TEWARI INS KALINGA Electronic Spreadsheet (Advanced) 

MULTIPLE CHOICE QUESTIONS 

1 Computer spreadsheet cell that is highlighted with heavy border is : 
 

 
a. Active cell 
b. Passive cell 
c. Locked cell 
d. Formatted cell 

 
Ans a. Active cell 

2 Rohan  selected the 4th row and 3rd column in a spreadsheet. Then what is the cell 
address? 
 

a.3C 
b.C3 
c.4C 
d.C4 

 
Ans d.C4 

3 Data available in other sheets in a workbook , can be consolidate by : 
 

a.Row label 
b.Column Label 
c. Both a & b 
d.None of the mentioned 

 
Ans: c. Both a & b 

4 Macros must be saved with extension in MS Excel: 
a. .xls 
b. .xlsm 
c. .vba 
d. .xlsx 
Ans b. .xlsm 

5 Which programming language does VBA is based on : 
a. Visual Basic 
b. Visual studio 
c. Visual Base 
d. Visual .Net 
Ans a. Visual Basic 



17 
 

6 Which of the following is not a type of referencing in a spreadsheet? 
a.Absolute 
b. Physical 
c.Relative 
d. Mixed  
 
Ans b. Physical 

7 Shortcut to open the list of recorded  Macros in MS Excel are  
a. Alt+F8 
b. Alt+F5 
c. Alt+F4 
d. Alt+F7 
Ans a. Alt+F8 

8 Macros options is available in Openoffice (Oo) Calc in which tab: 
a. Insert 
b. Tools 
c. Data 
d. Format 

 
Ans b.Tools 

9 In Data consolidate what are the operations we can perform, 
a.Sum 
b.Average 
c.Max 
d. All of the above 
 
Ans: d. All of the above 

10 In a Subtotal function what are the functions can be performed on the group of cells: 
a. Sum 
b. Count 
c. Average 
d. All of the above 

 
Ans d. All of the above 

CASE STUDY QUESTIONS (R) 

1 Ramesh wants to solve one variable problem, Suggest him which of the data 
analysis tools is best suited for him. 
a. Solver 
b. Goal Seek 
c. Scenario 
d. Data table 
 
Ans b. Goal Seek.  
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2 In spreadsheet, to apply  Goal Seek your cell pointer must be in  

a. The Changing cell whose value you need to find.  
b. The Result Cell where formula is entered 
c. The cell where your targeted value is entered 
d. None of above 

 

Anser b.The Result Cell where formula is entered 

3 Which of the following tools deals with multiple unknown values? 

a. Goal Seek 
b. Scenario 
c. Solver 
d. Data Table 
 

Answer C: Solver 

4 Shovit wants to combine and find the sum/average of marks obtained by the 
students in the previous three  periodic tests. The data is stored in various sheets 
of a workbook. Which of the following tools is best suited for him? 

a. Data Range 
b. Data Consolidation 
c. Data Review 
d. Data Merge. 
 

Answer b: Data Consolidation 

5 In Oo Calc , Which options should be used to accept/reject the changes in the 
shared sheet. 
a. Edit->Accept 
b. Edit->Changes->Record 
c. Edit->Changes->show 
d. Edit->Changes-Accept/Reject 
 

Answer d:Edit->Changes-Accept/Reject 
 

6 What are the operation we can do on the shared documents 

a. View the changes 
b. Accept/Reject Changes 
c. Edit the sheet 
d. All of the above 
Answer: d: All of the above 

7 Rakesh wants to apply a formula in the entire column of the spreadsheet,with 
respect to only one cell. What referencing he will use to get the correct result. 
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a. Relative Referencing 
b. Absolute Referencing 
c. Mixed Referencing 
d. HyperLink   
Answer : b. Absolute Referencing 

8 ____is the default extension of Openoffice calc. 
a. .ode 
b. .ods 
c. .odh 
d. .odg 
Answer: b .ods 

9 In a spreadsheet,absolute reference will be referred to.. 
a. $A$4 
b. $A4 
c. A$4 
d. A4 
Answer a.$A$4 

10 Sravan wants to do the same set of tasks to be done repeatedly like formatting or 
applying a similar formula in a similar range of data.Suggest him a suitable tool for 
that. 
a. Goal Seek 
b. Solver 
c. Scenario 
d. Macros 
Answer d. Macros 
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SNO NAME OF THE TEACHER KV TOPIC ALLOTTED 

6 Mr P VISHAL HAKIMPET Database Management System 

MULTIPLE CHOICE QUESTIONS 

1 

Which of the following is not a database programs? 
a. MySQL 
b. Oracle 
c. Writer 
d. OObase 
Ans: c. Writer 

2 

Duplication of data is called _________. 
a. Inconsistency 
b. Consistency 
c. Redundancy 
d. Foreign Key 

Ans. c. Redundancy 

3 
Which of the following is not the advantage of database? 
a. Sharing of Data 
b. Reduce Data Redundancy 
c. Increase Data Inconsistency 
d. Data Securit 
  
Ans. c. Increase Data Inconsistency 

4 
Which of the following will help to maintain unique record in the table? 
a. Foreign Key 
b. Primary Key 
c. Composite Key 
d. Alternate Key 

  
Ans. b. Primary Key 

5 
A foreign key is a reference of the ________ key in another table. 
a. Alternate 
b. Primary 
c. Candidate 
d. None of the above 
Ans. b. Primary 
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6 
SQL stands for _________________ 
a. Structured Queue Language 
b. Structured Query Language 
c. Structured Query Lang 
d. None of the above 
  
Ans. b. Structured Query Language 
 

7 
We can create query (in Open Office Base) in _______________________ 
a. In design view 
b. Using wizard 
c. Both of the above 
d. None of the above 
  
Ans. c. Both of the above 
 

8 
Which of the following will occupy more space in computer memory? 
a. Bigint 
b. Integer 
c. Smallint 
d. Boolean 
  
Ans a. Bigint 
 

9  ____________ is the most common DML command. 

a. Delete 
b. Update 
c. Select 
d. All of the above 
  
Ans. c. Select 
  

10 
Command to increase the salary of all employees by 15000.(table name emp and column 
name sal) 
a. update emp set sal = sal + 15000; 
b. update emp set sal = 15000; 
c. update set sal = sal + 15000; 
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d. None of the above 
  
Ans. a. update emp set sal = sal + 15000; 
 

 

CASE STUDY QUESTIONS (R) 

1 
Which of the following software is appropriate to store data about school students?  

a. MS-Access 
b. Writer 
c. Calc 
d. Impress 
ANSWER: a. MS-Access 

2 
Which of the following is not a database programs? 

a. MySQL 

b. Oracle 

c. Writer 
d. OObase 
ANSWER: c. Writer 

3 
Which of the following is not the advantage of database? 

a. Sharing of Data 
b. Reduce Data Redundancy 
c. Increase Data Inconsistency 
d. Data Security 
ANSWER: c. Increase Data Inconsistency 

4 
When primary key is made up of two or more columns then it is called __ primary key. 
a. Mixed 
b. Reference 
c. Composite 
d. Compost 
ANSWER: c. Composite 
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5 
 All the values in ________ are of same type.  

a. Records 
b. Table 
c. Database 
d. Fields 
ANSWER: d. Fields 

6 
_______________ are the basic building blocks of a database. 
a. Tables 
b. Record 
c. Fields 
d. All of the above 
ANSWER:  a. Tables 
 

7 
Which of the following is not valid field of table “Student” 
a. adm. no 
b.name 
c. fees 
d. Salary 
ANSWER: d. salary 

8 
When data is stored, maintained and retrieved from multiple tables then special database 
software are required called 
a. DBMS 
b. RDBMS 
c. Special DBMS 
d. All of the above 
ANSWER:  b. RDBMS 

9 
A field which is ______ for each and every record is called Primary key. 
a. Common 
b. Same 
c. Unique 
d. None of the above 
ANSWER: c. Unique 

10 
It is used to establish an association between related tables. 

A.Line 
B.Relationship 
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C.Primary Key 
D.Records 
ANSWER: B.Relationship 
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